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Use this guide for your first steps with the Agilent 6500 Series Quadrupole 
Time-of-Flight LC/MS system, and as a road map for your user informa-
tion.

What is the Agilent 6500 Series Q-TOF LC/MS system?

The Agilent Q- TOF LC/MS is a liquid 
chromatograph- quadrupole time- of- flight mass spectrometer 
that performs MS/MS using a quadrupole, a hexapole collision 
cell and a time- of- flight analyzer to produce spectra. The 
quadrupole selects precursor ions that are fragmented in the 
collision cell into product ions, which are then impelled to the 
detector, at an angle perpendicular to the original path. 
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What is the Agilent MassHunter Workstation Software?
You can set up an Agilent Q- TOF LC/MS with the Agilent 1100 LC, 1200 LC 
or 1290 Infinity modules and one of several ion interfaces: ESI, Dual ESI, 
APCI, APPI, multimode, MALDI, nanospray, dual nanospray or HPLC- Chip 
Cube MS interface.

The Agilent 6540 UHD Accurate- Mass Q- TOF also supports the Agilent Jet 
Stream Technology. This technology utilizes a super- heated sheath gas to 
collimate the nebulizer spray which dramatically increases the number of 
ions that enter the mass spectrometer.

What is the Agilent MassHunter Workstation Software?

The Agilent Q- TOF LC/MS comes with Agilent MassHunter Workstation 
Software that includes these programs:

• Data Acquisition – From one screen you can tune the mass spectrometer, 
control and monitor instrument parameters, set up methods containing 
acquisition parameters and worklists containing multiple samples and 
monitor real- time run plots.

• Qualitative Analysis – From one screen you can set up methods to extract 
and integrate chromatograms, extract peak spectra and compare data from 
different types of data files. More importantly, you can find compounds and 
generate formulas for those compounds. For more information on the 
Qualitative Analysis program, please refer to either the Qualitative 
Analysis Familiarization Guide or the online Help for the Qualitative 
Analysis program.

• Quantitative Analysis -  From one screen you can set up a batch of data 
files and quantify, evaluate and requantify the results should you want to 
do this. For more information on the Quantitative Analysis program, please 
refer to either the Quantitative Analysis Familiarization Guide or the 
online Help for the Quantitative Analysis program.

• Report Designer Add- in -  You can customize many of the reports that are 
used in the Data Acquisition program, the Qualitative Analysis program and 
the Quantitative Analysis program by using the Report Designer Add- in. 
Reports are created by using templates, Microsoft Excel and the Report 
Designer Add- in. For more information on the Report Designer Add- in, 
please refer to either the Reporting Training DVD or the online Help for the 
Report Designer Add- in.
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What’s New in Data Acquisition
What’s New in Data Acquisition

in B.03.01

• The Agilent 6200 Series Accurate- Mass TOF mass spectrometers are not 
supported in this release.

• The Agilent 6520 and 6530 Accurate- Mass Q- TOF mass spectrometers are 
not supported in this release.

• The Agilent 6538 UHD Accurate- Mass Q- TOF mass spectrometer is 
supported.

• The Agilent 6540 UHD Accurate- Mass Q- TOF mass spectrometer is 
supported.

• Agilent Jet Stream technology is supported on the Agilent 6540 UHD 
Accurate- Mass Q- TOF mass spectrometer.

• The mass range for the Agilent 6540 Q- TOF is 50 to 3200 when the 
Instrument Mode is 4 GHz High resolution or Extended Dynamic Range. 
The mass range is 100 to 10,000 when the Instrument Mode is Extended 
Mass Range.

• The mass range for the Agilent 6538 Q- TOF is 50 to 3200 when the 
Instrument Mode is 4 GHz High resolution or Extended Dynamic Range. 
The mass range is 100 to 10,000 when the Instrument Mode is Extended 
Mass Range.

• For the Agilent 6538 and 6540 Q- TOF, Dual ESI is the only supported 
source for autotune.

• You can start the second time segment at 0.3 minutes.

• New reference mass calibration algorithms are supported.

• The Agilent 1290 Infinity high performance Auto Sampler (G4226A) is 
supported.

• The Agilent 1290 Infinity Binary Pump (G4220A) is supported.

• The Agilent 1290 Infinity DAD (G4212A) is supported.

• The Agilent 1290 Infinity TCC (G1316C) is supported.

in B.02.01

• The Agilent 6210A (1 GHz only) Accurate- Mass TOF mass spectrometer is 
not supported.

• The Agilent 6510A (1 GHz only) Accurate- Mass Q- TOF mass spectrometer 
is not supported.

• The Agilent 6230A Accurate- Mass TOF mass spectrometer is supported.
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What’s New in Data Acquisition
• The Agilent 6224A Accurate- Mass TOF mass spectrometer is supported.

• Fast polarity switching is supported on the Agilent 6230A and 6224A TOF 
mass spectrometers.

• Agilent Jet Stream technology is supported on the Agilent 6230A 
Accurate- Mass TOF mass spectrometer.

• The Agilent 6520B Accurate- Mass Q- TOF is supported.

• Fast polarity switching is supported on the Agilent 6530A, 6520A and 
6520B Q- TOF mass spectrometers.

in B.02.00

• The Agilent 6530 Accurate- Mass Q- TOF mass spectrometer is supported.

• Agilent JetStream technology is supported on the Agilent 6530A Q- TOF 
mass spectrometer.

• Fast positive/negative polarity switching is supported for the Agilent 6200 
Series TOF. Autotune is also updated for fast positive/negative polarity 
switching.

• The MS2 transient accumulation time is dynamically adjusted based on the 
precursor intensity.

• Agilent VWD Models D and E are now supported.

• Gradient Delay Reduction is supported on the HPLC- Chip.

• The Agilent G1367D high performance Autosampler SL Plus is supported.

• Low cost vacuum gauge on Agilent 6530 Q- TOF is supported.

• Pfeiffer turbo pumps on Agilent 6530 Q- TOF are supported.

• Isotopic ratio determination is improved which affects autotune.

• For TOF and Q- TOF, Multimode autotune is supported.

• Agilent 6200 Series TOF APCI autotune is supported.

• Graphics are included in the Q- TOF and TOF tune reports.

• EZ- Access version B.02.00 is supported for TOF instruments.

• DA Reprocessing program is available to allow reprocessing of data files 
using the Qualitative Analysis program.

• Any language can be used to create scripts. 

• A worklist can be inserted into the current worklist.

• You can specify whether or not to combine exported results in the 
Qualitative Analysis program for each sample in a worklist.
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What’s New in Data Acquisition
• A custom icon is used to indicate a MassHunter data file. The .d Icon 
Changer program is available to change the icon for data files that are 
already acquired.

• Logbook notifications can be displayed in the taskbar in the form of balloon 
messages.

• The amount of free disk space is displayed in the status bar of the Data 
Acquisition window.

in B.01.03

• The Agilent 6520 Accurate- Mass Q- TOF LC/MS System is supported.

• The Agilent 6220 Accurate- Mass TOF LC/MS System is supported.

• The Agilent 6520 Accurate- Mass Q- TOF and the Agilent 6220 
Accurate- Mass TOF have improved low mass resolution, extended dynamic 
range and extended mass range on the TOF analyzer.

• For the Agilent 6520 Accurate- Mass Q- TOF and the Agilent 6220 
Accurate- Mass TOF, the mass range is increased from 10,000 amu to 20,000 
amu when the Instrument Mode is set to Minimum File Size.

• Data is stored in a compressed format for both TOF and Q- TOF.

• Data can be stored in both profile and centroid mode at the same time. 
This data is called dual mode data.

• You can override acquisition parameters from the worklist.

• The Time field in the Instrument Status pane now shows the Ready 
Timeout, the Elapsed Time, the Post Time and the Last Run time.

• You can change the size of the Device Actuals panel in the Instrument 
Status pane.

• Offline method editing can be done for the Q- TOF LC/MS, but only the LC 
part can be modified.

• You can specify the Molecular Formula in the Worklist. When the 
Qualitative Analysis program runs, the value entered in the worklist can be 
used in the Find Compound by Formula algorithm.

• You can change the size of the text in the worklist.

•  The G1315D is supported.

• Seal wash is supported for the binary pump, the iso pump and the 
quaternary pump.

• The Injector Purge Kit is supported.

• Excel 2007 is supported for Data Acquisition reports.
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What’s New in Data Acquisition
For information on what is new in the Qualitative Analysis and Quantitative 
Analysis programs, refer to the Familiarization Guide for each of these 
programs.
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Where to find information
Online Help
Where to find information 

Online Help

Press F1 To get more information about a pane or dialog box, place the 
cursor on the pane or dialog box of interest and press F1. 

Help menu From the Help menu, access “How- to” help and reference help. 

Documents

These manuals are delivered with the Q- TOF LC/MS hardware or software. 
You can also find a PDF version of each manual on the installation disk, in 
the Manuals folder. You can also display several of these manuals from the 
online Help for the corresponding program.

You can find a PDF version of manuals for the offline or related MassHunter 
products on the installation disks for those programs. You can also access 
these manuals from the Getting Started section in the Online Help.

Installation Guide This guide is used by the Agilent customer engineer to 
install the hardware and software, configure the instrument, and verify 
performance. 

Concepts Guide - The Big Picture Learn the background information to help 
you understand operation of the hardware and acquisition software.

TOF/Q-TOF Familiarization Guide Do the exercises to learn to use the Q- TOF 
LC/MS hardware and acquisition software.

Maintenance Guide Use this guide to help maintain and troubleshoot your 
Agilent Q- TOF LC/MS.

Qualitative Analysis Familiarization Guide Do the exercises to learn to use the 
Qualitative Analysis program. (This guide is on the Qualitative Analysis 
disk.)

Quantitative Analysis Familiarization Guide Do the exercises to learn to use the 
Quantitative Analysis program. (This guide is on the Quantitative Analysis 
disk.)
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Where to find information
Training
Report Designer User Information DVD Learn how to customize the Excel 
templates that are used to create reports. The User Information DVD contains 
movies to show you how to customize a template and familiarization 
exercises to learn to do to learn to customize a template.

MassHunter BioConfirm Software Quick Start Guide Learn how to use the 
BioConfirm software (The Agilent MassHunter BioConfirm software can be 
purchased separately. This guide is included with the Agilent MassHunter 
BioConfirm software.)

MassHunter BioConfirm Familiarization Guide Do the exercises to learn how to 
use the BioConfirm software (The Agilent MassHunter BioConfirm software 
can be purchased separately. This guide is included with the Agilent 
MassHunter BioConfirm software.)

Training

Familiarization Guide Use all three familiarization guides (Data Acquisition, 
Qualitative Analysis and Quantitative Analysis) to get to know the software.

Report Designer User Information DVD Watch the movies and use the 
familiarization guide to learn how to customize a report.

Training Courses Visit www.chem.agilent.com to view a listing of training 
courses for the Series 6500 Q- TOF LC/MS.
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Getting Started
Getting Started

Install the Q-TOF LC/MS hardware and software

Use the Installation Guide for your instrument to install the hardware and 
software and verify performance. 

Set up, run and analyze samples

The roadmap below shows you the steps to set up and run a batch of samples 
from start to finish. Follow the instructions on the next pages to get started 
and to learn where to find the information to help you with each step in this 
roadmap.

Start 
Here!

Set up, run 
and analyze 

samples

3 Set up and 
run an 
acquisition 
method

1 Start the 
Data 
Acquisition 
software

2 Prepare the 
LC/MS

4 Review results 
and find 
compounds 
with Qual 
Analysis 

Set up and run 
quantitation 
(optional)
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Getting Started
Step 1. Start the Data Acquisition software
Step 1. Start the Data Acquisition software

The instructions below include the following assumptions:

• The hardware and software are installed.

• The instrument is configured.

• Use instructions in the Installation Guide to configure the instrument 
for the first time and any time you change the LC configuration.

• The LC modules and the LC/MS instrument are turned on, but the LC 
pump is not running.

After installation, you see all of the Agilent MassHunter Workstation software 
icons on your Desktop.

• To start the Data Acquisition program, double- click the Data Acquisition 
icon.

The Data Acquisition window appears.

NOTE When Data Acquisition opens, the software engines automatically 
start. If for any reason, they are stopped and you need to restart 
them, double-click the Acq System Launcher icon on your Desktop, 
and click Start.

If you have recently changed LC modules, remember to configure the 
instrument again. See the Installation Guide for instructions.
10 Agilent 6500 Series Q-TOF LC/MS Quick Start Guide



Getting Started
Step 1. Start the Data Acquisition software
Four panes—where you do most of your work

When you first start the Data Acquisition software, the main window appears. 
You do almost all of your work within the four panes of this main window. 
These panes provide the tools to set up acquisition methods, run samples 
interactively or automatically, monitor instrument status and monitor runs.

Figure 1 Main window of the Data Acquisition software 

Show/hide the panes You can show one pane at a time on the screen or up 
to four panes. You can never hide all four panes. To show or hide a pane, you 
click the icons in the main window toolbar or you can use the menu items in 
the View menu.

When you click a pane, the active pane is outlined in blue. Press F1 to obtain 
help on the active pane. You can also drag a pane border to resize the pane.

Click a button to 
see the pane you 
want to use.

Instrument Status pane Real-time Plot pane Method Editor pane Worklist pane
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Getting Started
Step 1. Start the Data Acquisition software
Instrument Status pane With this pane you view the status of each module 
configured with the instrument–On, Off or Standby.

You also set non- method control and configuration parameters for the LC 
devices and MS and monitor the status of the device parameters during a run.

Real-time Plot pane With this pane you monitor the chromatogram and 
spectral plots in real time. 

S–Instrument Status; R–Real-time Plot
M–Method Editor; W–Worklist; T–Tune

Profile view of MSUser-defined signals and/or 
instrument parameters

Centroid spectrum display
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Getting Started
Step 1. Start the Data Acquisition software
Method Editor pane With this pane you enter acquisition parameters for the 
method and sample information to run individual samples interactively.

Worklist pane With this pane you enter sample information for multiple 
samples. When you run the worklist, the samples are automatically run in the 
order listed in the worklist.
Agilent 6500 Series Q-TOF LC/MS Quick Start Guide 13



Getting Started
Step 2. Prepare the LC modules
Step 2. Prepare the LC modules

Read and follow the instructions in the online Help for each of the tasks in 
the checklist described on the following pages.

1 Switch LC Stream to Waste.

While you condition or equilibrate the column, you can tune the Q- TOF MS. 
During this time you do not want pump effluent going into the Q- TOF MS, 
so you switch the direction of the LC stream away from the MS ion source 
and to waste.

If you have the LC connected to a VWD or DAD, you can still monitor the 
fluctuations of the VWD or DAD real- time chromatogram before a run.
a Make sure that the General tab in the MS Q- TOF tab is selected in the 

Method Editor pane.

b In the LC Stream (Seg) group box, click Waste.

c Click Apply.
2 Purge the LC pump.

Follow the directions for purging the pump in the User Guide for your 
pump.

3 Condition or equilibrate the column.
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Getting Started
Step 2. Prepare the LC modules
After you purge the pump, you set up to condition or equilibrate the 
column.
a Enter LC parameters, and click Apply to download them to the LC.

b Right- click an LC module in the Instrument Status pane to change any 
non- method control parameters, if necessary.

c Monitor the baseline and adjust the plot to make sure the column is 
equilibrated and the baseline stable. (See step 4 and step 5 on 
page 16.)
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Getting Started
Step 2. Prepare the LC modules
4 Set up to view real- time parameter values (actuals).

As you prepare for a run and during a run, you want to see the actual 
values of the instrument parameters. You can do this in the Instrument 
Status pane.
a Right- click the Actuals section in the Instrument Status pane to see the 

Setup menu item.

b Click Setup to bring up the list of Actuals available for monitoring. If 
you have configured a TOF instrument, the actuals for the TOF 
instrument are displayed instead.

c Add all the parameter values you intend to monitor, and click OK.
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Getting Started
Step 2. Prepare the LC modules
5 Set up real- time plot displays.

As you condition the column, you set up the displays to monitor the 
effluent.

• Right- click the chromatogram plot, and click Change.

In the Edit Signal Plot dialog box, you can select any type of display signal.
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Getting Started
Step 3. Prepare the Q-TOF instrument
Step 3. Prepare the Q-TOF instrument

You need to tune the instrument the first time you use it or after 
maintenance, service or pump- down and restart. You do not need to tune 
often with standard use. Agilent does recommend that you calibrate the 
mass- axis regularly.

If you are installing the instrument, please refer to the Installation Guide for 
instructions on how to tune the instrument for the first time. The instructions 
below describe the entire tuning process for an instrument that has previously 
been tuned starting with the Check Tune algorithm.

For the Agilent 6538 and 6540 UHD Accurate-Mass Q-TOF

Before running a Set Detector Gain, Standard Tune or Initial Tune, the 
Instrument Mode must be set to Extended Dynamic Range. After running 
one of these autotunes, if you want to acquire data with a different Mass 
Range or Instrument Mode, you change these values to the appropriate values 
for your analysis. If you change the values in the Instrument State tab after 
finishing the autotune, you must recalibrate the TOF or Q- TOF. 

You can only run Initial Tune, Standard Tune, Set Detector Gain, Quad 
Tune or Initial Quad Tune if a Dual ESI source is installed and if the 
Instrument Mode is Extended Dynamic Range. These buttons are grayed out 
if a different Instrument Mode is selected. If a different source is installed, 
then an error message is shown if you try to use one of these tunes.

You cannot use any of the autotunes if the source is a nanoESI, a Dual 
nanoESI, an HPLC- Chip or a MALDI source.

Diluting the ESI-L Tune Mix

You may need to dilute the ESI- L Tune Mix. 

When tuning in negative ion polarity, you probably need to dilute the tuning 
mix to calibrate properly. You also sometimes need to dilute the tuning mix to 
calibrate properly in positive ion polarity. The instructions for diluting the 
tuning mix are included in the Installation Guide and in the online Help.

Tune the Q-TOF MS 

1 In the Context list, click Tune.
18 Agilent 6500 Series Q-TOF LC/MS Quick Start Guide



Getting Started
Step 3. Prepare the Q-TOF instrument
The Tune pane appears in place of the Method pane and the Worklist pane 
in the Data Acquisition window. Note that you tune the TOF separately 
from the quadrupole.

Initial autotunes are appropriate for initial system installations, after 
removal/replacement of ion optics or mass analyzer components, or if 
standard tunes cannot complete successfully.

If the software was just installed, and an autotune was completed as 
described in the Installation Guide, skip to “Switch LC stream to MS” on 
page 24.

Figure 2 Autotune tab for an Agilent 6538/6540 Series Q-TOF

The Quadrupole section is only available if you have configured a Q- TOF 
instrument.

2 (optional) Click the Preferences tab.
3 (optional) Mark whether or not you want the system to automatically adjust 

the abundance of the calibrant ions. 

This is an advanced feature, and you probably do not need to change this 
setting.

If you mark the Adjust the abundance for optimal calibration check box, 
the system automatically adjusts the fragmentor voltage to reduce the 
abundance for calibration masses if the calibration masses are detected to 
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Getting Started
Step 3. Prepare the Q-TOF instrument
be out of the 50 to 650K range. If the fragmentor voltage cannot be 
adjusted low enough to cause the abundance level to fall below 650K, the 
system tells you to dilute the calibrant and then to try the calibration or 
autotune again.

4 Click the Autotune tab.
5 Mark the polarity to use when tuning under TOF on the Autotune tab. You 

can mark Positive, Negative or both. 
6 (optional) Mark the Pause Between Autotunes (for Calibration Solution 

Swapping) check box if you are using a different calibration solution for 
positive and negative autotunes. 

7 Click Check Tune to check the TOF mass calibration and optimization. 
Then, click Start Autotune (2 to 5 minutes).

If the system pauses between autotune to allow you to change calibration 
solutions, change the tuning mix to one diluted for the next tune as 
described in the online Help and in the Installation Guide.

You repeat Check Tune if the abundances are greater than 480,000 for any 
of the calibrating ions.

If Check Tune results are acceptable, then skip to step 12.

If Checktune results are not acceptable, then continue with step 8.
8 Click Quick Tune to use a limited set of parameters to tune the MS 

automatically. Then, click Start Autotune (7 to 10 minutes). 

If the system pauses between autotune to allow you to change calibration 
solutions, change the tuning mix to one diluted for the next tune as 
described in the online Help and in the Installation Guide.

You repeat Quick Tune if the abundances are greater than 480,000 for any 
of the calibrating ions. 

If Quick Tune results are acceptable, skip to step 12.

If Quick Tune results are not acceptable, then continue with step 9.
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Getting Started
Step 3. Prepare the Q-TOF instrument
9 Run a Standard Tune to use even more parameters (10 to 15 minutes):
a Click the Instrument State tab. 

b For the Instrument Mode, click Extended Dynamic Range.

c Click Apply.

d Click the Autotune tab.

e Mark the polarity (polarities) to use when tuning under TOF on the 
Autotune tab.

f Click Standard Tune.

g Click Start Autotune.

 For an Agilent 6538/6540 Q- TOF mass spectrometer, the source must be a 
Dual ESI source when running a Standard Tune.

If the system pauses between autotune to allow you to change calibration 
solutions, change the tuning mix to one diluted for the next tune as 
described in the online Help and in the Installation Guide.

If Standard Tune results are acceptable, continue with step 10.

If Standard Tune produces unacceptable results you can perform an Initial 
Tune (45 to 60 minutes for positive polarity and 30 to 45 for negative 
polarity). If this also fails to give acceptable results, please contact Agilent 
Field Support.

If you would like to use custom tune parameter values, you can also 
perform a Manual Tune.
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Step 3. Prepare the Q-TOF instrument
10 Set the Mass Range and the Instrument Mode that you want to use to 
acquire data. 
a Click the Instrument State tab.

b Select the appropriate Mass Range.

c Click the appropriate Instrument Mode.

d Click Apply.
11 Recalibrate, if necessary.

Calibration is done when you click the Check Tune button, the Quick Tune 
button, the Standard Tune button and the Initial Tune button. If you have 
just performed one of these tasks, you only need to recalibrate if any of the 
following are true:

• You change the Instrument Mode in the Instrument State tab.

• You change the Mass Range in the Instrument State tab.

• The peak abundances are above approximately 480,000 for the 6538/6540 
Q- TOF. You have to dilute the tune calibrant before you recalibrate. You 
recalibrate to get optimal mass accuracy.

a Click the TOF Mass Calibration tab.

b Click the desired polarity in the top left corner of the Tune pane.

c To select a different set of masses, click Load or select or clear 
individual masses in the list on the left side of the Tune pane.

d Click the Calibrate button.

e If you want to calibrate the TOF analyzer in the opposite polarity, 
repeat step b through step d.

12 Run the Check Quad Tune algorithm to check quadrupole optimization (2 
to 5 minutes).
a Click the Autotune tab.

b Click the Check Quad Tune button.

If the Check Quad Tune results are acceptable, then skip to “Calibrate the 
mass- axis” on page 23.

If Checktune results are not acceptable, then continue with step 13.
13 Run the Quad Tune algorithm to optimize the quadrupole using all its 

parameters (30 minutes).
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Step 3. Prepare the Q-TOF instrument
 For an Agilent 6538/6540 Q- TOF mass spectrometer, the source must be a 
Dual ESI source when running a Quad Tune.
a Click the Instrument State tab. 

b For the Instrument Mode, click Extended Dynamic Range.

c Click Apply.

d Click the Autotune tab.

e Click Quad Tune.

If Quad Tune produces unacceptable results you can perform an Initial 
Quad Tune (50 to 60 minutes). If this also fails to give acceptable results, 
please contact Agilent Field Support.

If you would like to use custom tune parameter values, you can also 
perform a Manual Tune.

14 Set the Mass Range and the Instrument Mode that you want to use to 
acquire data. 
a Click the Instrument State tab.

b Select the appropriate Mass Range.

c Click the appropriate Instrument Mode.

d Click Apply.

Tune reports are automatically generated in Excel at the end of a tune.

See the Concepts Guide for more information on the TOF and Q- TOF MS 
instruments.

Calibrate the mass-axis

Calibration is performed by infusing a sample that contains known masses 
into the source and measuring the actual flight times for ions of known 
masses. Using these times and exact masses, updated calibration coefficients 
are calculated. This process ensures accurate mass assignments for unknowns. 
Agilent recommends that you do this regularly.

Calibration is done when you click the Check Tune button, the Quick Tune 
button, the Standard Tune button and the Initial Tune button. If you have 
just performed one of these tasks, you only need to recalibrate if any of the 
following are true:

• You change the Instrument Mode in the Instrument State tab.

• You change the Mass Range in the Instrument State tab.
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Getting Started
Step 3. Prepare the Q-TOF instrument
• The peak abundances are above approximately 480,000 for the 6538/6540 
Q- TOF. You have to dilute the tune calibrant before you recalibrate. You 
recalibrate to get optimal mass accuracy.

1 In the Combo Bar, select Tune in the Context combo box.
2 Click the TOF Mass Calibration tab.

3 Select the Ion Source and Polarity on the left side of the Tune pane.
4 To select a different set of masses, click Load or select or clear individual 

masses in the list on the left side of the Tune pane.
5 Click Calibrate.

The Q- TOF Calibration Results dialog box opens.
6 (optional) Repeat step 3 to step 5 for the other polarity.
7 Click Apply to apply the updated calibration coefficients.

Switch LC stream to MS

After you condition the column and tune the Q- TOF MS, you switch the LC 
stream from Waste to MS.

a In the Context list, click Acquisition.

b Make sure that the General tab in the MS Q- TOF tab is selected in the 
Method Editor pane.

c In the LC Stream (Seg) group box, click MS.

d Click Apply.
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Step 3. Prepare the Q-TOF instrument
Monitor MS baseline and spectral displays

• If you did not monitor the LC baseline with a VWD or DAD, make sure that 
the Q- TOF baseline is stable and no spectra of interfering intensity appear.

• If you did monitor the LC baseline with a VWD or DAD, change back to the 
default Q- TOF displays.
a Right- click the chromatogram plot, and click Change.

b Select the MS signal, and click OK.

View the system logbook for events and errors

As you prepare the instrument, you may run into an error that you want to 
troubleshoot. You do this through the System Logbook Viewer.

• Click the Log icon in the toolbar of the Data Acquisition window, and view 
the logged events. 

• Or right- click the  icon in the system taskbar. First, click Enable 
Notification. Then, right- click the LOG icon and click Configure. The 
system can notify you of new errors and warning by showing messages 
from the taskbar.
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Step 4. Set up and run a method

An Agilent MassHunter Workstation software method for Q- TOF can contain 
acquisition parameters, qualitative analysis parameters or both. 

When you run a single sample or multiple samples in a worklist with this .m 
method, you can specify whether to run both data acquisition and data 
analysis or to only run either data acquisition or data analysis.

If you select to run both data acquisition and data analysis, then data analysis 
will automatically follow acquisition if qualitative analysis parameters are also 
contained in the method. You can also run a method to produce only raw data 
(acquisition only) or reprocess the data with a method containing only 
qualitative analysis parameters (data analysis only).

In this step you learn how to set up the method with acquisition parameters 
only, with qualitative analysis parameters only and with a combination of 
acquisition parameters and qualitative analysis parameters. 

Read and follow the instructions in the online Help for each of the tasks 
described on the following pages.

Set up a method with acquisition parameters

Do Exercise 1 and Exercise 2 of the TOF/Q- TOF Familiarization Guide to 
learn how to set up and run a method with only acquisition parameters. 

Before editing or running a method, set the options in the Instrument State 
tab in the Tune pane. 

• Type the values and settings for each of the tabs below.

• (optional) If you want to download the settings to the instrument, click 
Apply.

• To save the method after entering parameters, click File > Save As > 
Method.

• Type the name for the method in the Method field, and click OK.
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1 In the Context list, click Acquisition.
2 Enter LC parameter values.

Type the values for all of the LC modules configured for the instrument.

3 Set up to change Q- TOF MS parameters with segments and experiments:
a Click the MS Q- TOF tab in the Method Editor.

b To add a segment, right- click the Time Segment section and click Add 
Row.

The time segment will use those parameter entries with (seg) next to 
their names. Those parameters can be changed for each time segment.

c To add an experiment, right- click the Experiment section, and click Add 
Row.

The experiment will use those parameter entries with (Expt) next to 
their names. Those parameters can be changed for each experiment.

d Enter the parameters for each segment and experiment. When you add 
a new time segment, the parameters for the time segment that is 
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selected are used as the default values for the new time segment. When 
you add a new experiment, the parameters for the last experiment in 
the list are used as the default values for the new experiment.

See Chapter 3 of the Concepts Guide for an explanation of how and why 
you use time segments and experiments.

4 Enter Q- TOF MS parameter values:
a Click the General tab, and enter any General parameters that you want 

to change.

b Click the Source tab, and enter any Source values you want to change.

c Click the Acquisition tab.

d Select the mode of operation for the Q- TOF LC/MS: MS mode, 
Auto MS/MS mode or Targeted MS/MS mode. 

Different parameters are made available depending on the mode selected.

To learn more about these parameters and how they affect results, refer to 
Chapter 3 of the Concepts Guide or the online Help.

e Enter any values you want to change in the Acquisition tab.
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f Click the Ref Mass tab to set up the mass calibration.

g Click the Chromatogram tab to set up the chromatograms to plot 
during a run.

5 Set up a method with both acquisition and qualitative analysis parameters.

You can create either part of the method first.

If you want to add acquisition parameters to a method with Qualitative 
Analysis parameters:
a Set up a method with acquisition parameters.

b Click File > Save As > Method.

c Type the name of an existing method that contains Qualitative Analysis 
parameters.

d Click OK.

The method now contains both acquisition and Qualitative Analysis 
parameters.

NOTE The name of the method that contains only qualitative analysis parameters will not appear 
in the Name list in the Save Method As dialog box. Type the method name in the Method 
field and select the directory that contains that method in the Directory list.
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If you want to add qualitative analysis parameters to a method with 
acquisition parameters:
a Set up and save a method with acquisition parameters.

b Open the Qualitative Analysis program.

c Open a data file that was created with the acquisition method you set 
up and saved in step a.

d Enter the qualitative analysis parameters and change settings to meet 
your needs.

e Save the method using the same name that you used to save the 
method in step a.

The method now contains both acquisition and qualitative analysis 
parameters.

See the online Help to learn how to enter or change parameters and set up 
tasks for this method.

Set up and run interactive samples

1 Type the sample name, data file name and path.

2 To start the run, click the single sample icon, .

You can run the single sample in either locked or unlocked mode. When the 
mode is locked, no one can change the method or sample parameters 
during a run.
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Set up and run worklists 

1 Right- click the upper left corner of the worklist to display the following 
menu.

2 Click Add Multiple Samples.
3 Enter all relevant information, and click the Sample Position tab to specify 

the sample vial locations (make sure the specific sample tray type has been 
configured by right- clicking the autosampler device image).

4 Specify the locations, and click OK.
5 To set up the worklist run, right- click the upper left corner, and click 

Worklist Run Parameters.
6 Type the paths for the method, the Override DA method, and the data files, 

and click OK.
7 To start the run, click the Start Worklist run icon, .

You can run the worklist in either locked or unlocked mode. When the 
mode is locked, no one can change the method or the worklist while the 
worklist is running.

NOTE To use qualitative analysis parameters that are different than those contained in the 
method entered in the worklist, show the column called Override DA Method in the 
worklist by using the Show/Hide/Order Columns dialog box.

In this column, type the name of another method containing the qualitative analysis 
parameters you want to use for the sample. 

You can also type this method in the Add Multiple Samples dialog box.
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Step 5. Review results and find compounds with Qualitative Analysis 

• Use the Qualitative Analysis program to do these steps and more:

• Review results for acquisition method development

• Find compounds

• Identify compounds

• Do molecular feature extraction

• Export results

• Print reports

Refer to online Help and do the exercises in the Qualitative Analysis 
Familiarization Guide to help you learn how to use the Qualitative Analysis 
program to do these tasks.

Step 6. Set up and run quantitation 

• If you want to quantitate your data, use the Quantitative Analysis program. 

Refer to online Help and to the Quantitative Analysis Familiarization Guide 
to learn how to do more steps to analyze your data.
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methods
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